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(3%

VxWorks J&:3¢[E Wind River System A ¢ LR #FR I A, B Wind River 24 7))
HEH ) — A S HRAE RS . Wind River A R4 T 1981 4, 2 — LTINS AE RS
TER G A7 VAT AT, % AR SE A R Al 5 A U R s B A SR 2
Ao

VxWorks & —ANzA77E HFsL B R mtEae s nr R i A SE B E R % . BUHR
B () R PR B PR SIS P4 ) S AR IR . E T s WUOR SR AR AR R B S
SRR A, W RIS A ] HIEE T WU A 7EEE F-16. FA-18
iRl B-2 BRE S IENLANZ [ o b, EEAE 1997 45 4 H 76 KO3R8 ki 1 K R
i FAATH 2] T VxWorks.

1984 4 Wind River 2 w4 H B IR 55 — AN RAS--VxWorks 1.0.1, £ 1999 4EHEH T e If
FIRA VxWorks 5.4. M 1995 4ELLJS, Wind River Al 7 —&SemH/E R G TT RIS
Tornado.

1.1 Tornado 2.2 4%

Tornado stk A 2 SE Ak T s — AR & PR35 . Tornado 45k ARG &
N GHEE T A2 H b5 YR R R 2 T R FRAR A 5 . Tornado 43 2 = A& BE AR AT
Y
L IBATHEAE EAUR H ARHL_E 5 1028 SO R T BRI S R
CIBATHE A RRAL B B ERE . R EBY I SEI R R EE VXWorks;

TARGET PoweerPL

VxWarks/lxWeor ks WisP HEK
Sealable Run Time
LT —— s
Real-Tima Embaddad CaldFire
Application
SRARE

WindWisw e | MISL | e ] vl T

o e =HH
Wi 0 Fil | |

Herwoaking :‘:.-:h:]u [ M

WindPowar Tools =

POSIX Library

| TRird Pany amd
| Customce Toods

XPTANE HARHL, Tornado 45 7 & $e fit—A>— 3 i 4% A AWLA 1. 448 H
Tornado [T A N 8% )8 0 H FRALI s AN P A 21 B ) 27 5 B0 RE 0 T = RN
N FHIF R E R UE EEL( 2, Tornado T (M T HA R EEAEF L TE LN, ERAXRS
THRKEN L E, Tornado J& 55— ANSEHL T 24 HARHLZIEA BRI I & T HAT af 46 A1 H D) 6e
FAEMIF RS Y4, Fra LEAGES —ASFJe iR g5 45 (Target Server) AbHELE HFRHLK
Hil. FreATCieiESE )7 e Ethernet, I8E 58 4k, ICE {7 FL8%. ROM {7 FELA ok % /7 Wi 1)
W, P LR,
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111 SENRES
VxWorks ¥ ZH i~ E T 7R :

Real-Time System

SR, BB AR A (1 N ) K
® AT WH:
SEFI R GRSl D
AT-45 ()3 15
N
®  HAARHE VA R Y X SR A
ARG EICE, M T AL,
® AT IE AR R — bk AN ) (45 MR 5, bR Seoidepl, H—ME
25 1 I 2 5 ] AT 55 )5
® ifi{FES5Ia T Y (supervisor) B (AR RS0 H B A K8 — DIt
B, PFTE B EAE Nl AR R AD
® /i ENL B EARIGgTE; A8 HASHL BT IR AT

1.1.2 Tornado KT E

® CrossWind:
BREP (C 8 C++ LU SR 74 MM T H., Crosswind 454 1 EIETT
M AT 77 IR RRE i e S5 38 i 7 2, 91 G BT A R e AT 2 3
A DB R ) f 77 NS [FIRE, R BomAE AR i i g it 7 — A
L) AT AL R S N AR R b d S B — BBy o R 2 S S 2R
CrossWind 424t T ar 24T 17 Ak e 4 AL I 5 Fhdr 2
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Browser:
A RGN R (FE55 WEBAA. 5 5855 FAfE 2840 G DUdEAT W4 i )
Yigs. AU S HAR RS . Browser L TN HBERE, A AETHFERT—
ANE FRNAFRIWU . 38 Browser, HIFTRTLIOWESE S EL HEBAS). ALFEIC.
BV 88 HERRAE S HAR CPU MR R, X Gt g M RN 7F5 % DL K B
AMESSITEE S

WindSh:

PTG THLE HARHLZ A — A4 shell. WindSh & — R 2 G (1 IF
KTR, CHARRAAZ AT EAENE,  SOVERT I P A o S R P A e el
7& VxWorks B EMBIRE . EAMEBA — i 2 SIhEE, mHBAA C
EE TR, BEBMER L TATAT C e REA, #$UTKZH C BEH T,
AT AT R o XTI K, WindSh 2% >J ok LR T 8, A ] ELB A, ) 384y
SRS, WA g T BORT AN o

WindView:
e H ARG AW A 4T T H. mTHER B M SATS, TR Tz
A EAER . e e iR AN RGN T R i T T

VxSim;
PO SR A BLAR o PTAERER A & R SE G BT, AEAE AL L N RS e 3 AT 45 B
AHT.

Project Facility:
TREE BT H, BH N R P 5 vxworks A &,

VE: KEBH I T R AR e L Tel 364740, Tel (Tool Command Language), —#13%
21T Bourne Shell F1 C &5 IMIAIE 5

1.1.3  TornadoXXfFH

VxWorks [FIRFHB 733 S HLAR T IR, AHOG R EE S0 G~ (s AT AH N 1) 223 SCAF) -

1) ERGEHAE (I MC680x0, PPC, 1960, x86, ARM), it LLA5 #1%. ) Tornado for
PPC,
Tornado for x86, etc;

2) BSP AN[H CRIVEMEERILAE, I8/ 58 I 8%, VMEbus 4% 145 T LAZE Tornado for
x86 HL17 386,486, pentium 25 % i BSP;

3)  YmiFAsANE (n[iE), target server AN,

BSP /& Board Support Package [M4E5, %AEE W H TR ARS8, FEIREIT R
RN I R G T R R S (L IR S P IR B SR o AN I 1R T B A i AN XA AT 0]
R AR, G eI, AR e OS MIKENFEF,
HilKE e HAL (HardWare Abstract Layer Do SZfn 3 JURP# fig 4 2200 34
oy, T RAMRA RGP AL R AR A O RS e 6T BSP A [ EEA#, DRtk
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TE S 3 BSP 16 HAAIA SR AT TAEAEAT — R B 1 AR R0 o RN TR GBI 7 1) Sk
2K WindRiver 22 @] %F BSP [ ERA# s 1] T4 OS [WIRBNFEF (= ML BSP ¥ 3C kS mf
DU HD PO IR ARG & R s & 104 H 5 2, ks BSP 47 T OS (H3KRZ) 1)
A — 2 BE L. XTI BSP UL IS FE T 1 AR UE, Al vt AT T i & A i i A =X
FRG P AL B AL 1) SR N T A 7 N T R GE (Total Solution) . fEIXFRIF & & %5
BSP e & H B R T A W FET, UV R AN A B2 B AR R,
1M PR IRAE IR AN FE P AE F O RGP IEH T 3. XTI RIRA R OS 1 AKJE,
F-¥s BSP B RS RHREAE -4 (i % 2 (HAL) AT CPU (HIKSIFEFE HAA 24 . A &% Fh B A%
HA—EMIER, HlFHE SR, X BSP [ELARHAA KA H 2 HHR .

P N X HERRARHA — € (19 T, nT LU &R ] 5 ) B AR R HS i %% A )
Mo FERE B IS AATT— LA SR AR AR ) — 26 ) B S PR AR o PR T ok
HOMRPEE R EXHTHOEH T LRI RH]: SPbarE L g brvk
FRFP ARSI AL o AR IX S s DI S0 3 — AN IL ARG e AR AN AT AT A
PEFE IR . UIFREATE 1. SRR IRRFI, RN E R T
AEEAI IR . ARG, XSO W . el AR, JLF A
PR 6 42 HRI A5 B B U B AE [R] — AN AN 3K CPU 24 h, AR A5 A 1%+ CPU Core Flix
AT S . WIRBEXS CPU Core MIVC#& IR A- A HIREATHI G, AATIFEREHE OS Hli#
RIKSNFE T B EXS CPU HEATIER RN T fft, ANLEE T RRAZFAE A I A
PRSI AR, B BB T BB AR H A AE 2 5555 . K BSP J&—Fl g
AR RN G SR A A BEAT Rl P B A (R RSP I o HiR MR R AR A i il
I R AT B 5E At 4, AN TG BEAE U] 2558 1, B MRS — Lo — [ 3h1E.
Wi 6T E AN DRERER, REAE R IBA R O, P22 /D, M
B IR TFAEA L 5% . 7ERIH BSP 4w’ Driver B, 4afe N 0 2T i
% Driver FIHILAINT LA ST LA 1) N 220 AN T7 22 T R A6 10 I EL AR 40 15 5 i 56 1 B
HFET o ARV LARK I TARRCE, I H TR0 AR (0 ARG 1 6 & e A IR s R
Aoy AR I TT, A BSP SCPE FE W] LOKOK o H S AT BTk . 7F BSP (4%
R BR TR R R R PR A A ARG A, I T B AR I G A R s R
FE0 53 LB — G5 B (R DK Sl R P R B0 o IXRE IR BSP 1T LAAS AR A TATAT ) #4 R 4
FIKENFRST, AFIE o] DME A B AE RGEFNIRBNRE P (W T A SCHE P, nT AR O (58 1 B AR R
HIFR OS SUKSHFET . AEHUFITEGL R, OS 5REhFR (RS R L 75 28 s et 7 &5
IR BSP SCHEEI LRI T A .
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R % Tornado [ 30 1F K -

zetup fﬁ-ﬁﬁ?’

include T HILIH

sre Velolordemoi B2 R

Tornada host host-oz FAlFAETHE
bin AIIITICM
lib tornade T BEE

resource GUL, Tel, Helpﬁ%ﬂﬁ:
tel  ARMETCLE

share HZERMIEAM ( EEVHE FHIERCHR—PET)

docs  TESEHTMLI H5Eh
confizg E0E. SRiEvworksFI4ERIICY

——s11  SRNECE I
bspHame & BESF

comps  wiwork=2H I Y

tarzet

proj S rrworks bootable T 3T
h weworksSR 0
1ib  weworksIR{HRIEEI 5
sre EbodvawerksiE T
unzupported TH » 3Ezh

R T 2 n 1 Torado SCAHFJE G A AT, 3 SRR (A2«
1) host-os H >ARIEAR I EHUBEERIERAE R GE 0 H3han 44,

x86-win32 Fi A5 1) windows £ 48 41
sun4-solaris2 Solaris #1ERZ LN
parisc-hpux10 HP-UX EHL

2) Jtarget/config/all £ T boot F£/5F1 vxWorks JFAAMITEACHY, IR 21 S0,
JEHSHLTINA, RNEBAFAN R

3 ATEAEESCHE Clib), HE AN S LSO, wmfER T2 b, X T vxworks
RGPS/, FEANES, W

Library Routine Include files
taskLib taskSpawn taskLib.h
memPartLib malloc stdLib.h
semLib semTake semLib.h
IstLib IstGet IstLib.h
sockLib send sockLib.h
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1.2 B/BEFERE

Target H Frbi

RS232

—
wAEE
YRR
tmmwr
g

PN

R AN M (T R R
Tornado I, —/AMJFRIREERIEST, TFELLFFPE:
& LE L H AL
& CENUAEEA G, P L P AR A
7E\x86-win32\bin '~, 17 torVars.bat AR, HIRUCEM AR &, 0 48 BERCE 4F
TCP/IP 1%, &% 3-H1 hosts 324 (K. booting #5743+
JFU4 Tornado VMM 4%, wixregd (573 H kiR 2525 1 L H);
FIH HFRPLE 31220 (boot parameters) /a3l HARHL (JaHi/r4H);
BCE T 5 8 H bRk 45 #% (target server) |, H bR 45 a5 2 8 3 =AU & T HFH bl
SRZANIP

L 2R 2R 2

1.3 bootingdEANHE

X HESHLR B, 76 B RHE TR ZAH —A boot F2/%, boot F&/FHM EZIIRERL] T
vxworks W%, ITEA boot B35 EEAIE vxworks [ WAZAFIRAEATAL , T8I A4 T Bt £ 3K L
£F vxworks 45 I¥) boot FEF LA —4c W) default boot line, ‘& 488 T 3k%F vxworks
WAZ P& R, 1E boot F2/F7 A BT, &4 T-#k NVRAM HLIHIAE boot line, WK, MIZEH
(1) N 2595 N\ BOOT _PARAMS £5H4 1L, AR5, A a7 Ml vxworks WAZAI L4544 -5 312
.
typedef struct  /* BOOT PARAMS */

{

char bootDev [BOOT DEV LEN]; /% boot device code */
char hostName [BOOT HOST LEN]; /* name of host */
char targetName [BOOT HOST LENJ; /* name of target */

char ead [BOOT TARGET ADDR LEN]; /% ethernet internet addr */

char bad [BOOT TARGET ADDR LEN]; /% backplane internet addr */
char had [BOOT ADDR LEN]; /* host internet addr */

char gad [BOOT ADDR LEN]; /% gateway internet addr */

char bootFile [BOOT FILE LEN]; /* name of boot file %/

char startupScript [BOOT FILE LEN]; /* name of startup script file %/

6
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char usr [BOOT USR LENJ; /% user name */

char passwd [BOOT PASSWORD LEN]; /% password */

char other [BOOT OTHER LEN]; /* available for applications %/

int procNum; /% processor number */

int flags; /% configuration flags */

int unitNum; /* network device unit number */

} BOOT_PARAMS;

NHiEboot lineZs#y:
bootDev / W4, LOKM Amotfee, flashhjtffs0
unitNum  / W&HICY, IR0
procnum  / cpuffAbEs S, —/H A0
flags /B NG BT
0x01: e A1 AbHE 220 11) R G das il
0x02: ¥ JHE# symbol sFI4: i symbol s H Fr#lsymbolsi
0x04: Z5iFEBhES) Bl % Aboot line)
0x08: thikboot (NTHEEERH P AN)
0x40: 1 FHBOOTP or DHCP client
0x80: i HHTFTP3k M image, 75 WI{ FHRSHERFTP, FHFTPI pwAs 4y %
0x100: 1 HARHLE LA —AMRIARP client

ead / HFRHLipHihl, SAEWR 2, 4 AR

bad / AR

had / FEMLipHik

gad / WO, G R BN HARHIALE AN R EL, FF

bootFile: / f#/iflvxworks imagelf]i&4%

usr: / A FHFTPERRSHIN ] 7 44

passwd: / ftp password

other: / MIEE S BN A T %, 2 N BlChsE 5 5 B IR, G SRR Ay R (1) D9 2%

W%, bootss AIRYPIE M4 £
hostname: / EHL4, TR
targetName: / HArHL4
startupScript: / A%, fFbootllfGMtarget shell BFAT

{Fboot line™, e, b, WS EESAN BRI, ARt v] DLike S {E, 7 pw= " wiefsH
L NTFZH, HAMF

boot device : motfcc

unit number : 0

processor number -0

host name : host

file name . vxWorks

inet on ethernet (e) : 192.168.2.97 (H R IP Huhk)

host inet (h) : 192.168. 2. 42 (FTP Server MJFEH| Host [ 1P Huhib)
user (u) : vxworks (FTP Server 17 4%)

ftp password (pw) 1 vxworks (FTP Server A& 48)

flags (f) : 0x0
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EAMI R, MmotfecOM ) 8. &3 2$5 EHost EHL LHIFTP Server, fiiH]
vxworks : vxwokrs ] J7 /S0 5 5 IF R #vxWorks

fEvxworks BLIHT, EFXRE—FRIIBSP (fFAMYBSP? SEA ) , #E &K BMECE XM, 7
C:\Tornado\target\config\bspname\config. hH, FTFFconfig X, ¥iF 2 _L1m AT i i
default boot line, ¥ NRZEM M HEMRIE IR SIS SUAT S48, 2 f76 A Dk,
TESEIN Y R G R TT A I B, A4 R H BAPCHLYE A H AR LR R IIFE . EAHLPCHI H FrAl
PCZ IR P SR ER T EGR W VA TR o T R ZHH bR O W, 28 125 1 o5 ] FRLpR
WG NI T TR D IR

1) ESUE HRC E S \\Tornado\ target \config\bspname\config. h. £ X AN FE I 4, HH
ZFRANE], WINE2000 Az e 28 HENE, 3COMEL KM HELT, Intell-F NEEX,
Intel82559M K Afei , 3C905B PCIM K helPci. (LASCOMBAA M+ A Hi)

2)  EFXFHESHLEM A, #define INCLUDE_ELT, [HI #undef Hogr ki
7t config.h ST SO R R ZEAS (= 3COM ) 52 B 47

#define IO_ADRS_ELT - 1/0 Hbil
#define INT_LVL_ELT RS

3) 1&Mi#define DEFAULT_BOOT_LINE f5& X
#elif (CPU_VARIANT == PENTIUM) (f&utAT )5 1) DEFAULT_BOOT_LINE)
#define DEFAULT_BOOT_LINE\

"elt(0,0) EHLFR N4 :vxWorks h=FEHL IP e=HExHL IP u=8E3%H "4 pw=H% th=H#x
L&
%4 #define DEFAULT_BOOT_LINE\
"elt(0,0)comps:VxWorks h=10.132.101.88 e=10.132.101.82 u=x86 pw=xxx tn=x86"
HRE: X TPCIM-R, T E2, B SN R 1 1/OMubE R 5

4)  E R B A
AR AW SR W AU EAE R A €
< fETornadoBE R IAEE il Build3E ., #EH{Build Boot Rom, iEHEXTIKIBSP,
P Image Abootrom uncmp, OK.
< HEADOSHET R NAT, $UUT A4S \tornado\host\x86-win32\bin\torvars (E I Ay
AT B H sk F\tornado\target\config\pcpentium; 474
mkboot a: bootrom uncmp

H: image SCAFMIRISE
vxWorks_rom : A LLE 2| ROM [, BA T 5K Shell 1. A K401 vxWorks .
vxWorks.st : i 17 5 R K vxWorks.
vxWorks.st_rom: #J L5 2] ROM [, i 345 52 A1 Shell (1] K46 vxWorks.
vxWorks.res_rom : #] LA %] ROM K. i #7552 A0 Shell 1. HAG EdE B L2 A
LEBA R4 1) vXWorks .
vxWorks.res_rom_nosym: 1 LIS %] ROM 1. A B BRI W AA . A R4
VXWOrks
bootrom: J&#if¥) bootrom .
bootrom uncmp: A HE4iFbootrom .
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M. BEAEE BN ik
1.7Econfig.nH K INCLUDE_ATALHGHE S
2 &% config.h HL[H)
#define DEFAULT_BOOT_LINE "ata=0,0(0,0)host:/ata0/vxWorks "
3 K H brfilifi kg 24k, Hvxsys.exe ({Ehost/x86_win32/bin/ ) A
4. ftbootrom.systifE kAL L, #53 H AR L
5. HEARAE B vxworks OS2 H brifif s TS 3 OK.

D #HigdBootbal THE (FZEH B2 HHbHr i e hlid %)
7t Tornado 13517514 Bootbal T 7%:
FEF— e “Location” 4 c:\myprojects\BootPen\Project0;
FESR ke “ABSP” CHARIFI BSP, U1 pcPentium;
Buildr ity LR, AEVxWorks.

2)  JAdhTornadoZHfFFTP Server  (Host) [VE: WURAMNEE MBI, AHHE, N
¥ b5 A i vxworks SCHEFE N AR AT ]

35 Tornado 411 FTP Server, 7 WFTPD % I /% £ #. Security H ] User/right...,
LEFCHRH B £ New User... i~ d BG4 A4, P 440 86,
DA XXX

FR3E R B vxWorks FT/ERR H sk, 7EIEh c:\myprojects\BootPen\Project0
W PEH F 32 Logging ' Log options, fii Enable Logging. Gets . Logins -
Commands . Warnings.
e, HRAEHER AN HARHLEIK, 5 23h H LR AT FTP 7 M 0L 2k
VxWorks & 4% .

i R M2 M EHLIFTP F2vxworks image, 7 FHAC X2k, FETRKMAAT.

N1 A&booting il FE H K —LE 40 5

1. Ean BTSRRI EEAERR H i ANboot 4L, LRI RLETRD, XAl E
Htbootconfig hSCAFkA& e B I 1], sliéhflagFHEDR s Clntfedie 8l 278D
AN, i default-boot-line[f1 5 8 24 @ILT T4 Aboot 4, JiikN:
i\ : $dev (0,0) host:/file h=# e=# g=# u=# =+ , XA AT R RS B K
i A omhg T . [Alboot-line# x4, Tl Ap, FI A A S S HL -
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[VxWorks Boot]: p

boot device : motfoo

unit number : 0

processor number : 0

ho=t name : ho=st

file name : vxWorks

inet on ethernet () : 19%2.168.2.587
ho=st inet (h) : 192.168.2.47
user (u) : vEworks

ftp password (pw) : vxworks
flags (£) : 0x0

2. BA BTSN

IT11111311111010000101001111111111111111
ITT111111111111110111111111111111111111
IT111110111110100001000010111111111111)

11111111111 1111 1111111111 11 1111 (R}
1 111111111 111111 11111111 11 1111
11 1111111 11111111 111111 1 11 1111
111 11111 1 1171 1 1111 111 111111111 1111 11 1111 11 11111
1111 111 11 1 111 11 11111 111111 11 1111111 1111 11 1111
11111 1 1111 11111 11111111 1111 11 1111 1111111 1111
111111 11111 111111 1 11111 1111 11 1111 11111111 1111
1111111 11111 1 111111 1 111 1111 11 1111 1111 1111 1111
11111111 11111 111 1111111 1 1111111 1111 1111 1111 11111
1111111111 11101111111111111111
11111111111111111111111111111 Development System
1111111111 111111111111111111
111111111111111111111111111 VxWorks 6.1
1111111111 1111111111111111 FERNEL: WIND version 2.7
11111111111131111111111111 Copyright Wind River Systems, Inc., 1984-2003

CBU: Freescale BQ37 MPCES41E. Processor #0.
Memory Size: Oxe000000. BSP version 1.2/4.
Created: Jamn 10 2008, 15:11:14

ED&R Policy Mode: Deployed

WDE Comm Type: WDEB COMM END

WDB: EReady.

WRARAE B A S R P BT A —FE, AT RE R AT LA IS O :
1) 7E55— Attaching network interface....7% %7 done 45 2: M -KREIAK]
2 ) Loading.... 547 HHEL vxworks image MR/ : R B 42 B RAT )
3) Loading...54677... A 5 —RIEE = oy BEHIAC M2k
4 ) Starting at... 5 AL FE75: FIHE image JGRL:

3. HEEMIA:

££ WindSh B % X\ reboot;
ZE H Ml EF% CTRL-X

10
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1.4 # rtornadoF &KIFIE

7EHFRPLAR R LLE, B 0L 1 target server FC & JE i shitd sk fm, B HFR
BURE AL Aok T, AP RIS O T, 8 PRt AR 0F F 3 H bz
BLZAT T .

BA146FE—F taraget server fRIFEH]:

The Target Server

—

09

G
%)

=

=
A

wtxregd

/
VxWorks

\ 4

WDB Agent

\

DN
2),
3.
4),
5.
6).

5 HFrHL_L 4 debug agent 3 ;
BRI BN A BT I 2
FHLIE R 53R

h N RAE BFHL 2 HE N A7
247 HArHL RAM HL (R RE A QR B 5
L 110 BE & 3L

T 1) Tornado I H.A# il WTX (Wind River Tool Exchange Protocol )[F] target server
T, target server FRKEEIE K4 EIEAE HARHL LY WDB ARHE, axX it G T ML T 2%
Hu 7 7] target.

HE: wixregd (2SR ), AZAE target server 2 B Ja 2, B4 T H 75 22 [A) target
server EZIIME A .

N EAR AN B R

11
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Configure Target Servers

Target Server

Copy |

nunriptim|tmfigu.ratinn 1
Remove

[T Add description to men

Target Server Name — | Target Sevver / |
Target Server Ernplrt:i.lhck End L[
] i & Back Timeeut (sec) Re-try
Change Property

| I

Target Hame/IP Addred192. 168.2.97

Command Line

tgtevr, exe 192, 168 2 97 -A -= -V =B wdbrpec -R
Target Server Command — 7| [C:% -E¥ ¢ E:'‘workivliproj\npc8S4l
Window "defaul tivxForks

0E I Launch Cancel Help

7

Launch Button

1247 Tornado(tornado.exe)
PATE 14 Tools | Target Server | Configure, #H1 H br ik 45 2% ¥ B XHEHE, it New
FEAE— AN HI L
T E Description 38 (nJ DMERBED;
¥ & Target Server 3%k (i AT E ;s
7 Change Property 3£ Back End T CZI & EHLS HbsHLW A iEE:, 5 4 W
CUEEE, B A %R, TR0 configall.h SO, BTN PR EERE VxWorks %),
WA R, E$E wdbrpe, AE HAx 1P 44 st b 45 H ASHLIG 1P 4% olidtbhil (g
W IP 44, PURRFES IR Z), WRET R 1P 4, %A1 HOSTS U4 il IP 44
5P HihER R OCER, WA R A, EHE wdbserial,  EBEAH AR H ORI R R (3
B BRALTH AR AL R A2 H BRHLIR R D
7t Change Property 3£t Core File and Symbols 3R, ¥t File Tk AAH N 1) 30 4F ([
HARHL LIZAT W AZ 280, At Launch, 1817 HARHRS 45
PATH A4 File | New GIEE—/NFTHISCHE, JHHT I Sn’E 4% Editor GZnH 38 Difie AN
SEARBROR, n] LA e g 4R 4 W Source Insight)
FARG PEAE RS, R E AR o)y GRS R AR (VRGN A IS T .
TEHCRH IR H b R 4545 o
AT Hir 4 Tools | Debugger 1247 11828 .
AT 64 Debug | Download R IR H Az (o)

12
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{E Editor % B E T .

AT T4 Debug | Run 3R IRHE,  ZOREIA A DR ST, G\ 2 R0 e 4L
BEAT IR

AT iy 4 Tools | Shell J&47 Shell. #JLA7E Shell % A E /BN 4 )RR, N7, &F
555012 BBYALTI AR W% (TS BAF. (58, ERES. WO
FER

PAT R Hiir 4 Tools | Browser i21T Browser. £ Browser H ] LA FT 4541 % . A5 HLAl
MWL W5 (WSS, B, (F55. . WAESX) BEE.

WDB f{#

Host/Target Interaction

tgtsvr

WDB Agent

Back end

A

WDB {2 (WDB Agent) 12177t HAx#l I, fL3K target server F1 Tornado tools:
D, BN fr:
2). WEBHFRWT A
3. A, . ks BERT S
4). VA R
5). PRGN G5 s

WDB Agent 7] it & 1
D, A{EAES . ARG MR debug
2). A EFE[A target server [IIE TR T 2

target server f1 WDB agent il il WDB (Wind Debug) protocal #4738 .

13
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2 Project

2.1 Downloadable project

Tornado {fJH] T.F% (project) A1 T FE[X (workspace) K4 FLH I ANHS ., Mg H
vXWorks. & fill g 1E 5

Project J& —/MJE SCE AT 3k SR SRS, workspace & 41 AH 5% projects
SIf S

7 tornado K, E+% File->New Project... JFaA4: il TRE:

stepl:

Create Project in ¥Workspace ~¥orkspaceTest® r7|[5_<|

fhat would you like to da?

.ﬁCreate a bootable Valorks image (custom com. ..

C 1
'&.’Create downloadable application modules for. .. neE

dds

Help

[v Show thiz window on startup

Bootable & downloadable:

o NNy N H+Vxworks+Bsp
® iE A ANFEIIIAEL, Vxworks K RS S IT «
N H+IEE (Vxworks+Bsp) , Mg WI: ppe, x86, i),
® JiilL: bootable - SEHEN ]
downloadable --- X, 7E IR L PR R 5
®  BUUUE—RFERMIET, e AL H AR

Bt DA Y 3% 4 downloadable, 5E#EM ] (ke 2 falsh) 4% bootable;

Step 2: FANHT LR E

14
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Create downloadable application modules for ¥z¥or... ?|[$_(|

Project

Hame:

[Projectl

Location:

[E: vwork'sXproj'\Projectl L. o

Project description (optional)

“Enter description herer

Workspace
f* pdd to carrent Workspace
(" Add to a New or Existing Works

| =

Help | Cancel | |

Name: T Fi4: Location: T Ff7E WorkSpace: JF A (AJ LA DRS4S

Step 3: IEHF LFEMEE

Create downloadable application modules for ¥z¥or... ?|[$_(|

H Specify a toolchain for building this Project.
This toolchain can be set explicitly, or can be

copied from an existing Downloadable Project.

Would wou lilke to base wour project on:

(" An existing project |

# A toolchain |PPCSSHNdi ab

FFC440znu
PPCBO3di ab
PPCBO3 gnu
PPCEO4di ab

FECAO4 Eu

Hel Cancel  |PECESKE gnu
i | =5 |PPCEE0d: sb
FPLARMN =M —

LA AT 0 RIS, ] DL ik $E;
kR, TLLIERE H AR,
®  ANFERM IBATI : BEPER;

FESRR FISATIN : LEPEAR Y R I

P EZAE R TEATEHELRL, T LI A R H 5

miled | L L

15
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Step 4: A H SN H -
A LA B34 Tornado B EENHE4THF &, File...->New, & TR cle++304F;
WISz 7 30 main.c:

#include <vxworks.h>
#include <stdlib.h>
#include <stdio.h>

int Add(int a, int b)
{

return a+b;

}

void main()
{

int a,b,num;

printf("hello world"\n");

a=1;

b=2;

printf("%d+%d=%d\n", a,b,Add(a,b));
}

Step 5: g iRl

ﬁh&kﬂ@ﬂé[

F—/ Mg build

5 A4 build all

BN Compile

SEPUANFE: A TR R, WREARIT, S A3
45 BT AR SO I TR JF A3ha 38

RIEARFICA R TR BT PRI
YRR U CSORH N [ J e

Step 6: R AESCAER] HARHL
2 SUREH/INE
®  UURAGHIB, s S

Bl 4 rmmsnne
BRI 58 S 2 B, — e

16
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¥z5im Launch: 5elect Image and Opt... EE]&E]

YilWorks Image

¥xSim includes a fully—operational wersion of
WindV¥iew, WindView support for additional targets
1z avallable separately.

Select the executable VilWorks image to be

(" Custom—built zimul:

Image: ||: ATornadeZ. 2. Lhtargethconfighsimpehvaorks.

Launch Options

Froceszsor mno. : ]
Memory Size Z00aoo0

0K | Cancel Help |

ok JE A 2l T A

™ ¥=zS5im0

Velorks
Copvright 1984-2002 Wind REiver Svstemn=. Inc.

CPT: VESim for Windows
Funtime Hame: VelWorks
Funtime Version: 5.5.1
BSF wversion: 1.2-2
Created: Ot 8 2003, 07:50:26
WDE Comm Tvpe: WDE_COMM_PIFE
WDE: Ready.

BT AR S5 A Oz T Vxworks AT B (3K 5] ) ;
IR R Cprintf)

JA 8] Target Server:
e BI—B58 a2 BN THI R 15 AE

17
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¥z5im [Lannch: Lannch Target Server ?|['5_<|

Target Server
b Target Serwer named “wvrsim@jianglijie”™ is required

and will be started
Details >*

Cancal | Help |

ffi € Ja 2 RS Target Server;

BREER) i

Pz SHELL 28 Fph T Ao 2 0L 5 41

Shell vzzim@jianglijie IZIIEIFZI

S S S S S

S S S S S
Py Py Py Py Py
Py Py Py Py Py
LEESSS SSSSS S S SSSSS S S SAS
LEESSS S S SSSSS S S SSS T o E H & D 0O
S S S S S
S S S S S

AL AL AL AL LS Development Swystem
SIS SIS SIS SIS SIS
SIS SIS SIS SIS SIS
LA LA LA LA LS Ho=t Based Shell
LS LS LS LS LS
S S S S S
Py Py Py Py e Version 2.2
S S S S S
s s s s s
s s s s s
s s s s s
s s s s s

Copyright 1995-2003 Wind Fiver Sv=tem=. Inc.
C++ Constructors-Destructors Strategy i=s AUTOMATIC

-
2 [

BEN: moduleShow, %FJashfER, W LIE ] Vxworks CL&4)H 5,  HIREE 4T

o . 2
RS TR ] AL

18
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Download objects

EHIEE D) | ) ST T en > & & ey E-

....................

E] simntll. aut

prae | Download |

JAEERI(T): |Object Files [k oik. out:*. ) | Bt

1F Shell =8 X\ moduleShow:

Shell vxsim@jianglijie =3
LAAESE SEALS SIS SAASS S S ~
LAAESE AELLSS SAEESS SAASS S S T © R H & D O W
Parry AL PAELLS S LA
Py ST KL KL LA
Ly Eray E E ey Developmnent Systen
S SIS SIS SIS S
S SIS SIS SIS S
S SIS LI SIS Py Ho=t Based Shell
S AL SO P S
IS AL SO SO S
A S L L S Verzion 2.2
S S £ L L
S £ o o o
o o o o o
o e o o o
o e o o S

Copyright 1995-2003 Wind River Svstems. Inc.
C++ Constructors-Destructors Strategy i= AUTOHMATIC
-

-
—» moduleShow

MODULE HAME HMODULE ID GREOUP # TEXT START DATA START BSS START
vEllorks . exe 0=x1113278 1 0=z401000 0x454000 O=z461000
=imntD]l . out 0xll125aal 2 0x1250%6c 0xl250e24

walus = 0 = 0x0 =
— \_f
<l >
A E BN HWIEAT T .

2, MAICZ FEGEHE:

Step 7: IR

o Jazhiikds: |ﬁ|

® ziT: ji_

19
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Eun Task

Tazk |pru:ug5 tart ﬂ

Erguments:l

[v Brealt at entry po

K | Cancel | Help |

2R Task A BCAT T EL (K task, FLARBEN;

3 6 33636363636 36 36 36 36 36 36 IEIEIEIE 36 IE 3036 I IEIEIEIEIEIEIEIE 363636 363636 36363636 36 36 36 36 36 3636 36363636 36 I I H

progStart — start the sample program.

Create warious =emaphores and spawn wvarious tasks, while
incredibly little error checling.

EIETE T I

RETURNS: CK
o

*

STATUS progStart (woid)
1

semBCreate (SEM_0Q _FIFO, SEM_EMPTY):
semBCreate (SEM_{Q FIFQ, SEM_EMPTY):

- syncSemld =
dataSemld =
curriodeSemlId = semMCreate ( SEM QO PRIORITY
| SEM_INVERSION SAFE
| SEM_DELETE_SAFE):

pCurrHode = HULL: <% Just in case *-

WUERHES L Rsl,  IFEEES A At.

® EWI
T UL AEAR Y AT 5 T R —F9;
o il TA:

=t %] 0| 5 2w|wle 2E8=EE
LA [F) HoAth ) —FF

2.2 bootable project

A DL FF A 2 bootable project:
® 7 IE U
® il vxWorks image;
£F4™ bootable project #5 /& 5ET— M E ) BSP, £F bootable project B, R4S
I7] vxworks A% 2 i IR — 2 1)

1% bootable project 25 ¥§:
stepl: [d] L
step2: [ I

20
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step3:  WLFE TREFRES

Create a bootable ¥Vx¥Workzs image (custom configure. .. r'? |r5_<|

Specify the Board Support Fackagze (BSF) which will
provide board-=specific code neesded by VaWorks.
Alternatively, wou may base wour Froject on an

axisting Bootable Froject
VxWorks Source Files will appear in wour new Froject.

Only those which are dymamically generated will be
duplicated in the new Froject’ = directory.

Would weu lile to base wour project on:
(" An existing project | __J

' h ESP

|C:\annad02.2.lﬂtarget\cnnfig\adEBEED Lo

Tool diah vl

Help | Cancel | < Barcl | Hext > I |

FRHE H L bsp EREAH N AR ACE , A PNFHSHL: JE An existing project nJ L4k 7k
DLRT ) TSRS E, AFHNCE, % ABSP U AZ)FEH e . CESGE I

step4:

Create a bootable ¥z¥Works image (custom configure... '7|[$_(|

The Project Creation Wizard will now create your
Bootable Project.

Workspace [E: 'work'+w¥proj'forkspaceTest. wsp

Froject [E:'workhw¥proiiProjectl'\Project]. wpj

Bazis ESF [C:4Tornade?. 2. 1htargethconfi gt ad=G260
Help | Cancel | < Barck |

Pl B AR THRATEFHERL, AT LA R H 5

21
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I York=pace: Workspace... [Z”E|E|

Build Spec|default d

--§8 WorkspaceTest P
¥ PerfTest Files
-
[Z] linkSyms.c
[Z] priConfig.c
(Z] rominit.z
[Z] romStart.c
[Z] swsblib.s
[Z] swslib.c
(Z] usrdpplnit.c
+-(Z] External Dependencies
=-{Z] Object Modules [default]
£ linkSymz.o
priConfig.o
rormlnit.o
rormSkart.o
auzdlibo
awzlibio
Lzréspplnit.o
wiork s hd
< 3

Files | “Works | Buildz

TR =A@, Files, Vxworks, Builds, FTii——/44:

Files:
B linkSyms.c and prjConfig.c---- TR A& 7= 4 I B SCHE, B8 AW a0

) ST

B romlnit.c, sysAlib.s, sysLib.c, romStart.c---—- & [ JT- 46 S04

usrApplnit.c---- #1464 P RE,  FH P FR BSOSO R 2 H 2K

B prjComps.h and prjParams.h---- T FE&h A = A Sk S0, A0 & AL R 2
H1H

Doobbbobbob

22
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M Yorkzpace: Workspace... g@g|

Euild Spec|dsfault

+ -l C++ components
+ -l +COM [Component Object Mod
+ -l W+ usion
+ -l application components
-l development tool compone:
& Lo TEST mdine synpart
& sy
& timex
& triggering library
¥ % Compiler support routine
+ - WDB agent components
+ -l ‘Windview components
+-jll loader components
+ -l show routines
+-fill symbol table component
+ -l target shell components
+ -l hardware
-l network components
+-fill basic network initializati
+ -l network devices
+-jll networking protocols
+- il obsolete components

4 *

Filez Witadorks | Builds

Build (JL 2.4 75)

2.3 HERERLBvXsim

1\

23

XN IR 7R T vxworks image 13T A T I iR F 2hhe, BAR RN K
ST CALE A, T BRI AR R B, R SR IR IR TE R A o
FEE PRSI, I s R A B, fesf i PRAESE S B, W] include Y
exclude
B, I B JE v . BIKRAFHE — T AT A, &
Hamg AR b, WMENKDIRRER, U RKESERN, W%
MR, BEAFREEXNEERAE A # include 3K, WIRETE Hisdl k3
shell 2R #E45 include _E “target shell components” #44.

VxSim & VxWorks $& i (1) 75 5256 5 WA 7 5 VxWorks HARHLIIEL, 116
FAEAEIR SCRE o AEFELETT I, VXSim FISATAE B ARHUEEAE 11K B8 VxWorks FREEAH ],
P& N H . rebuild VxWorks W%, 5t i 548 FL S48 FH FxvEE BSP 111 VxWorks 48 X
TR —FE,

VxSim 1, image £ 415 EAL— AN FEAT . B TAESAESE EHLA CPU £,
IR AR 2 1584 T AEES BRI BEAE, SANE &I R & IR BN R
HARR 5l R
Drivers: T KB FEF 75 2 SR AZ HAEH], V52 VXWorks [ £ IR S P2 711
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2. RS VxSim 41§ 1] pass-through 0¥ R 45 (passFs) B #2207 in) T AEws LS.
3. Networking : Tornado P4 [ VxSim ANGEAS F 28 DyRE; A4 MG S 34 s D Re 4L fF ]
LS 57 M 48 T B

Tornado L% T —A HARHLT SLI A RICAS, & s AT — N3l M4 Hr.
TR, —en ki 5 W STREAMS, SNMP, F1 Wind Foundation Classes 7t i Jiit
K FAAEA

i VxSim
Jash: MiER— AT EIEER H AL B ThaeR, VxSim H3lE 3. @l GiEsk R
BEHLS, il vxSim R 2, IR HARHUIRSS 35 VXSim 2 A 3))A 3.
PR LA 24T S Ek T R4 3 8l VXSim,
EHEFN: 1F Shell T CTRL+X
B 7F windows , CH% .

2.4 Bulid B

Il York=pace: Yorkspace... _'

[l Bnild Owtnut

: build specification ~default’

Build Spec|default

C/C++ compiler ] Link Qrder ] azzembler ] linker ]
¥ gPEIETesl Builds General l Rules ] b acroz ] )

- {8 WorkspaceTest

Project1 Builds ToslChain:

P ictoult [FPCEOZ i ab

& default_rom
& defaul_romCompress | BSE [C:/TornadeZ. 2. 1/ target/ configf ad=B8260

& default_romR esident Help

+ bnc8247 Builds
T bncB8270 Builds
¥

dids

bnc8280 Builds
+ - diTest Builds
¥ mpcB247 Builds

Cancel

——-nCad A

Wik default AR, FTIFgmt @k, W b, Harids A ciE s ss .
C/C++ compiler TT_I 52 X T debug Flags:

Properties: build specification ~defaunlt”

General ] Rules ] bl acrog ]
C/C++ compiler l Link Order ] azzembler ] [irk.er ] ()4 |
[v Include deb infoi Optimizati -
ncluide ebllg 100 1P 1:“113_ 10T |1'I.IZIILE J Ca_n.:e]_

—g —tPFCBO3FH: vaworksSS —W.c:, —imismatch—warning=2
-ewlSh4, 1551, 1552, 1086, 1047, 1547 -Xclib-optim—off
—Xansi —fAstrings—in—text=0 -Wa, —Xsemi—is—newline
—e11516, 1643, 1604 -Xlocal-data—area—static—only — Help
¥size—opt —IE: fworlgfwiprojfProject]l - -
IC: fTornade?. 2. 1/ targzet/ configf ads8260 -
IC: fTornade?. 2. 1/ target/h -

did

W

Tool ||:1|:|: Include paths. .. |

24



F AT
Include debug info #514 sets the debug flag(-g);

Optimization level 14 & Zr ¥ #: b2 (0,-01,-02);

Flags vary with CPU architecture. Some flags shown here are:

-00

-0

-ansi
-m68040
-nostdinc
-fvolatile
-fno-builtin
-1 dirName
-DCPU=...

Tornado 2.2 JFRINIEAT HIRES

No optimization

Source debugging support

ANSI function declarations and prototypes
Generate output for a MC68040

Don’t use usual UNIX include directories
Variables referenced throught pointers assumed volatile
Don’t use compiler built-in functions

Location of header files
Preprocessor definition of CPU type

25
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3 WindSh and Browser

3.1 WindSh(WindShell)
311 faisr

A EHLE HFRHLZ 18— 4 shell. WindSh & —FhelEH 2000 1 7T &
TR, CRAMRBEOA R g EYE, Ve U R A7 A 0 R R A b el e
VxWorks A i (AT Bl RS . e AMERAT B SE S INIhaE, mHB RS C EE
MIBETHRE AL, REBEAERE L TATAT C B ERIAK, PATRZH C BETHT, MK
SR . XTI KL, WindSh 2 3] ok LR R o, A LR (8, X i i
5 AT R T BT LAY

WindSh &AM BERAETHLA M C G S MRLS, Wik e nligsr N3 bl L
FTAT ek %, A4 VxWorks FIN g6 %, Tornado #h5eid EMRE LM T A a5
TCL.

WindSh A AT ARERE JLT- B A 11 C 15 1A, 17 HLaT RLSEILBT A it B .
EREG UG PR BRI AT S HBRATS WE
Wiskis MIERWS; G817, D, GREHUTIET: BENT. e B BRATE.
AT B RS YIR. WA O CPU R BAERE NN SR (15,
fF5a. WEI. WA, 25 467 Hbsblo

312 Bl

B3 w447 windSh phobos (HFRIRSS#:44FK) ; S5 Tool->Shell; I
H4.
&b PPEEE[Ctr1+D]; W exit() B quit(.

3.1.3  Shellk§ts

1/O ESE Ml FF 01 TR HGIRE ARV N BB s s e b v i s o Bt
BT, trEMANE R E M3 Tornado Shell. ffH Tel iR shConfig &k
WindSh FREEAF & SH GET TASK 10, SZIR 1/0 EA7 .

BRERSANT: BT RS A AR 2 I T IR 5, AR BEN [Ctrl+D],
Shell & HFFNFLBEAS . HHTUGRSEBAS TG b [Ctrl+D] HniE
A B AR S N 1k

FTENAEE (Synopsis): $EANTEINA 4G, LB ANTH + [Ctrl+D] nILLE

INTIT AR, RN () Ay A GRS E BN .
BR HTML #Bh: B4 G, R8N + [Ctrl+W] . K2 Hshil
W RZAT A TR I AE R

MiER—A4T: [Ctr1+U]
ENKLL VI piBan 4 Esc
B 5IH: NI B A AT R4 ] DL s i B -t ) oS ik

M. AT U N R Bl S k.
BT 1) C A ERF# T LAZE Shell BLAH TR M. thnl ULE C RIEAX P AR &,
WindSh 3535 & : ffiHH ? shConfig i 215 Fr 1A &
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SH_GET_TASK_10: A s E 110 FiE .
ON: Hi5E i) %] WindSh; OFF: 1/0 /3| HFRPIEHIG .

LD CALL_XTORS:

LD SEND_MODULES: # % load #=,.

LD_PATH:  ChBORGEM R, H “7 Wit . 1d m24840)5, Shell #
TR AT R e AT H 3, 25 2] LD_PATH W& 612,

LD_COMMON_MATCH_ALL:

DSM_HEX_MOD:
R BhshConfig&Telidk #8, Frilim Ay 2B 2shConfig.

3.14 WindShHE&4

3141 fREEM

sp()

sps( )
tr()

ts()
td()

period()
repeat()
taskldDefault()

R 5008 —/MT%% (priority=100 & [F{E A AT45 1D, EifEH)
(taskSpawn)

Bl —AMES%, R E

WA — AR TS (5 taskResume A [H])D

el —AMTES (55 taskSuspend 7))

MBR—MME% (5 taskDelete H[A])D

Bl — A5 I FH o8 BT 45

Bl — AN A R AT 4

W IR M AT /T4 1D,

3142 EEREER

i()

iStrict( )
ti()

w()

tw( )
checkState( )
tt( )
taskldFigure()

3143 R&GER
devs( )
Tkup ()
1kAddr ()
d()
1()
printError( )

version()
cd( )
Is()

BRRGHERE, AU AW RESE (EEEWHANL, AT
e s A—FO

KT 1), HHRAHHARI—IK

RIS 1) TCB 5 B

BRI HRAT S MVEAE R .

R EHERAT S RIS B

BOR—AMES WA HERR &Y, B e TS5 SR T 7
WoRHER ISR

HRAAT 4511 1D, LL K 44 75

I HEHLR G LT W&

List symbols from symbol table

List symbols whose values are near a specified value

Bor HEHLNAF

Disassemble and display a specific number of instructions
g5 B IR R E

SR VxWorks AN

U E EALTAE H s (AN HARPL

FI G EAL A H R et

27



11()

pwd( )

help( )

h()
shellHistory( )
shel1PromptSet ( )
printLogo( )

Tornado 2.2 JFRINIEAT HIRES

FIHE AL TAE H 3% F SR 415 S
BoRTE EHUCUET TAEH 3%

7R Shell 4[4 B
BoRBAL AN 20 A4

W E oK Shell 4

AR C iR A% Shell &R

{7~ Tornado Shell %[

3.1.4.4 RGEBEHAIER

1d( )

unld( )

m( )

MRegs ( )

b()

bh( )

s()

so( )

c()

cret( )

bdall( )

bd( )

reboot ( )
bootChange ( )
sysSuspend ( )
sysResume ( )
agentModeShow ( )
sysStatusShow ( )
quit( ) or exit()

I AR BB H AL, IF SIS run-time
M BRAL A7 A IR 2 2 R R0 A B

V1.0

Modify memory in Width(byte, short, long) starting at adr.

N SE AT 55 A B A7 (A
BEE A T
AR
FUDERERTI N — 4482

O ERER, (Rl 7T e

MW ARk 25

AT, EBETH R R ]
TS BT W7 o

TR — A W

HHT )R 8)) targe server

B4 boot ZHUIRAFAE

R EHPRHUREI SR, ARG

R EHFHUREE SRR, ARG R [P BT 558
SRR (R 80 ARSI
WRARS R (suspend Y running RGERI LD

3.1.45 X% 4 (WindSh Commands for Object Display )

show()
browse()
classShow( )

taskShow( )
taskCreateHookShow( )
taskDeleteHookShow( )
taskRegsShow( )
taskSwitchHookShow( )
taskWaitShow( )
semShow( )
semPxShow( )
wdShow( )

msgQShow( )

75 shell & 3T EVEEE X 21015 &
1F Tornado browser &7~ & [RI% %

Show information about a class of VxWorks kernel objects.List

available classes
B4 TCB /5 B
WIRAE S5 BB R A1
WIRAE S5 MR IR 51 2
WIRAT S5 FFAE AR T A
WIRAE S VI B RS &
BN AT B
CIRESENER
IR POSIX {5 52115 &
BoRE TR R
o BASIAE B
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mgPxShow( ) 7R POSIX i 2 BA B 115 &

iosDrvShow( ) WIR RGBT TFIE S

iosDevShow( ) WIRRFRAMEE

iosFdShow( ) BIoR RS 4 descriptor 115 B
memPartShow( ) BRI R G

memShow( ) IR RG 7 IX 25 PRRT 70 e 25 ) 1) e B A
smMemShow( ) Display the amount of free space and statistics on

memory-block allocation for the shared-memory system partition
smMemPartShow() Display the amount of free space and statistics on
memory-block allocation for a specified shared-memory partition

moduleShow( ) Show the current status for all the loaded modules
moduleldFigure() Report a loaded module's module ID, given its name
intVecShow( ) Display the interrupt vector table. This routine displays(nt "~ A~ a] )

3.2 Browser

AT RGNS (T4 HERAG. 55855 RIAE s i A5 DU T WL 1) Y 45 o
ATCAF AR 1 HAR RS- Browser J1 G T N HRERE, NAFISAERI—A H s N A71H)
Wef%. Wik Browser, /AT LIMISE S RS ATEOEC. BIIMTHI 2%, Hirk
fERTEOL. HEF CPUAEHIZ., X G &s MR 75 3 LA REAME 25 PR AR5 o

ALAE AT U 2 7 .
Memory Usage

Module Information
Object Information
Spy Chart

Stack Check

Target Information
Tasks
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TR || SZEDR || R

M Brow=~r 192_ 168.2.  9T@jianglijie

~ 1|7

| Target Information

kemorny zage
Module Information = —
Object Information FoA7@jlanglijie
Spy Chart d
Stack Check. F

T arget Informatian EHHDrkSE'E'l

Tasks

LS ) . -0 o0AA

BSP : Freescale PQ37 MPCA541E
Memnory : Oxe000000

Link : WDE Agent RPC

Tzer 113

Start : Fri Jan 11 15:35:5&6 2008
La=t : Fri Jan 11 16:02:32 2008

Attached Tools

windsh (jlj@jianglijie)
windview (jlj@jianglijie)
browser (jlj@jianglijie)

3.3 Spy

VxWorks Jz HARR IS S AL A T, v] - T-X 24545 R4c1 43 H1: Spy A1 WindView.
WindView HA5 B S R, WTHF L RS0, AT4-IRETH LI e KRG HEM T fiad
S, HBUREE R IT & FRES Tornado (% FF. Spy AHXH & Zhag e — HAF A fRife, EEHT
G AT SRR CPU (5 2

1. HBhE B

Spy i AL T RGN BN B I B O AT 55 e v SR AT I o B I B
W A ZEANGEAL T 100ticks/sec. T PowerPC860 R4 =, VxWorks A5 $2 4t 7 % B int4h
IXEHAEFHUEALAS . [Tornado]\target\src\drv\timen\ppc860Timer.c, % U fiL ¢ ] CPM Timer2
VE R I Bhii . WRAE RGEBETE R CPM Timer2 JE¥cA He flig, A8 20 T4 Bh i o zh F2
PRl AN I o B S LA

2. ME VxWorks
] Tornado 11 B FEAL T LB E VxWorks. BF DL P I 5 1 2
development tool components --> spy
hardware --> peripherals --> clocks --> AUX clock
W ASE S T TSR E S, W LA R %€ S, FFAE OB project:
#define INCLUDE_SPY
#define INCLUDE_AUX_CLK
EPIRPT B O T AT R (G Shell)fg k21 Spy, i 5 ZE 4 symbol L HIECE, AL
‘FIJFI H:
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development tool components --> symbol table components --> symbol table initialization
components -->select symbol table initialization --> built-in symbol table

3. JFER{EM Spy

A[AREGAE Shell Wh E #21RH Spy L H . f# 77k W Fl
1) spy(freq, ticksPerSec)

ZHRALE A B task: spyTask()KRHAT G v FIi 15, 4F freq PR 15— K. ticksPerSec
2 At Bl IR e A o T CE
2) spyClkStart(intsPerSec) F! spyReport()

561 spyCIkStart S JE 34 Bh IS 4d,  intsPerSec &4 B I A REFb vh K vk 8. R A
JE I L A spyReport WA it 45, 5 A Bk A spyClkStart Lk get- ZdE A g k
YA spyReport LUK 148 v 50k -

spy K4t vl 4 S 2 target system console ¥ target shell, 7] LLZE host Sif (118 T
H. Shell #1' Virtual Console Window US4 o GEvk 45 R 5 1 4% Task. H e 4511
T2+ Kernel F1 Idle 437l o FH (RIS 1A) B 43 LU AN ticks %, L B
£ I Tornado Online Manuals.

3.4 WindView

1. PE VxWorks
1) include "development tool components -> Windview components".
2) include "development tool components -> WDB agent components
-> WDB agent services -> WDB target server file system".
#EAHE View Graph (1] Timeline %I 5 24 I (8] Ak bk (seconds), 1 AS & B4 11
sequence numbers Ak bx, I FE W R ECE (R BSP A1 3 HF):
3) include "hardware -> peripherals -> clocks -> high resolution timestamping".
4) change "development tool components -> Windview components —>
select timestamping" from "sequential timestamping" to"system-defined timestamping"

2. W& Target Server
1) Tools -> Target Server -> Configure...
2) TEXTUEHE Configure Target Servers HiE$¢ TSFS:
Target Server Properties -> Target Server File System

3) MCE b
check "Enable File System";
enter the root path(H T-47JiX Log File);
select "Read / Write" option(#7 AN F WindView, TSFS v i AR
] % 4 "Read Only");

3. TFE windView
1) Tools -> WindView -> Configuration...
2) {EXFURHE WindView Collection Configuration Hfic % Logging Level:
a. Context Switch Event-Logging Level (CSE)
WU B SC, BUR BRSO IR, e 55 Uk,
TP BT/ S AL R PR IR AR 4
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b. Task State Transition Event-Logging Level (TST)
4d5% CSE Level [T 5 B (A 1 B SCUIH AR B AT AT 25 RS 1)
I¥, ARMESRESIITBE IR RS FECE N CUH).
WRAFFSRESMITH, AT RESIRET LR, W semTake(),
semGive, taskDelay()% .

c. Additional Instrumentation Event-Logging Level (AIL)
2055 CSE Level fil TST Level (K143 15 5.
20550 FIride instrumented library(taskLib, semLib, msgQLib,
wdLib, memLib, sigLib) 6 G A 4, At A5 B3
DI EAT 55 RS -

3) fEXFiEHE WindView Collection Configuration H £ %41 Properties,
P X 1EAE WindView Control Properties:

a. % Ring Buffer: H41{4.
b. AcE Upload Path:

(1) Direct to Graph: K £ 4 H £ 27~ 7E host [ View Graph H;
(2) File via TSFS: R dls A% Jf 4715 r ftgtsvr/eventLog.wvr;
(3) Socket via TSFS: K% ds I 1% 2il/tgtsvr/TCP:hostname:6164;
(4) Socket via TCP/IP: R £ #% 4% %] hostname/6164;
(5) NFS to <I>file:</I> W44 A& I A7 {E/leventLog.wvr;
T
EH 7@, FTFAERCE VxWorks B €17 "development tool
components -> Windview components -> upload path(s) -> TCP/IP
socket upload path initialization", &4 150l /& B .
NG, FHEAE target L RCE 4 NFS.
() @RI AL H I\ 2 View Graph, B3 W%,
AU RS . A 7 R @B)MI) I, 7558 File -> New 61—
WindView Log, VMEEor EAE R IEdE . 1FH 7 (L) & %4 H 3) Launch
—~ View Graph.
Jr QMG AL H S S, B A HRE SR, WA bR
2 J5 H File -> Open T T BT {47 1 WindView Log SCAE(*.wvr)BE1 720 #7
JrR (1) QFIB) M AL k4% & Target Server, J7z0(4)F1(5)1)
A% 4252 Network Facilities.

c. Ft'E Upload Mode:
(1) Deferred: 5&RK4E, T LAk;
B B2 target 1Y memory BRI ) target 12k g S MRS
(2) Continuous: R4, W A%,
B KB R 3Z target (1) memory R X target PEBESSIEL K,
(3) Post-Mortem: {1 T ZEHLE S A i it i) 73 A+
Fi . BRAEIAHENL T User Reserved Memory [X 5[] Ring Buffer 1,
MARFE [ LG, F2 BAER] host FREAT 47 .
7E:  User Reserved Memory 17T sysMemTop F1 sysPhysMemTop 2 [d],
1E 248 boot Al AN G 27, JF HAVH] caches

4, FFEHAEH WindView
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1) Tools -> WindView -> Launch...
2) FEXTUGAE Launch WindView H i $¢ Target: TargetServerName@Hostname
3) XI1EHE WindView Control TargetServerName@Hostname:
Tl G IR H s
ikl STOP: 45 1 RAE U «
4l UPLOAD: A% FITRAR ¥ £ .
4) FyPFAE R WindView (1) 512
a. 18t Triggering # WindView %54 % 4 ;
b. £ WindSh 5% Source Code ' 1 F§ WindView API: wvOn() and wvOff() .
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4 CrossWind

4.1 Debuggingfiisr

VxWorks BAT R I A TR HARHUN IR P 10 I 7 A7 PR, —
Pt RO AN R T I, WA RS BE W S W N RS0
ks SR RATSS R (B . W E R R AL BT, HEA
ARG R AL TARIRA . RIRREXS A RGeS, ] — AR — BT IEAT,
—ANEAT AN, R IR IR, T R g R gt TR

4.2 AESEAHAIR

TEARSREAS, fE— DRSS, fE—MES T, 50— MESh &N
A BRI RAERAEN . XA — N L Rk —> TCB (4 HIHY, &4
R4 —A TCB, PRt — /N AR —MT 5, ZIRRLMTES S 25 3l LA
WA —MEMIE LGRS — MRS, P DA LM 55k 22 8 3l LA SR A 5%
FAh s T EAERR AT S A PRI 26 — 4B AU AT DN taskSuspend(0)ifi £, FEAT ZAT 55
3 W55 50 n] Be s AR IR AT AT -
FEAT S PRBUT A MES P, AL SIS T I i, I AT 54 0,
MAREN RS
R HBEHRMTS, AREIIR ISR;
AL, AU 52 attached Task;
Y attached (E4515 1L, REH L EAES M ISRs gkEHa1T;
55 WDB ACEE (1 tH 7 =2 T k8l 7y =

4.3 FRGHEAHAIR

ARG A IR R SR (External Mode), fEUtIAR, target server iZAT1E
VxWorks 24t 4b

REGPABR T, ARV R EHE A VxWorks #8175 258 . RGN —AMES
HRMNY 2R ISRS, A ISR IBITFEAT S5 b F 32 Ah, FF HATAA AT 558 R i T
HA ],

ERGWRAEAT, T AR ZAMES . FW RS FET (SR), T mIEA R
4.

Tornadol.0 I EE R, 7ERGH FHATRF IR, A HARHLZ A 2420048 i o
IEAS . Tornado2.2 A FRBEHR AL T3t W L 3E T RGBSR ThBE(END Thig). R4E
SRR S, i R EATH & A, SREE SOt C:\ Tornado \ target\config
RGBT, run A RTH, ATEMER WindSh iR

Frm: ATRAIRAESS ISRs LAKAZHT (pre-kernel) [ VxWorks 44T

W7 A REAS R G5 1L
YRGS, AN WDB ARERIEAT AR e X, Rk, 5 WDB
AERRE T XA Polled #2:L;
T I UK PRI, 2 T 3CRF Polled Al 1 754 H END - o (73:: Tornado
FRATIREN 57 45 Polled #EX J RG240

H: RGBTSR B4
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riili debug->attach, MATZAA B R Gk

ritli debug->detach, M RGBT 455 2
7t debug-command-line &, B Hdr44 (gdb) attach system  (gdb)detach
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